
 

 
 

Mozilla 1.5: Mail and Contacts  
Learning Guide 
 
 
 Understanding Mozilla Mail  

Take a moment to understand the elements that make up the 
window and how they will be used.  
 
 
 
 

 
 
• The Navigation pane allows you to select folders within your 

inbox 
• The View pane displays the e-mails within the folder you have 

selected in the Navigation pane.  
• The Mail toolbar contains buttons for many of the common 

tasks you will use in Mozilla. 
• The Reading pane displays a preview of the e-mail selected in 

the View pane.  
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Launching Mozilla 
• From the Start menu, select the All Programs submenu. 
• From the All Programs submenu, select the Mozilla 

Thunderbird folder. 
• From the Mozilla Thunderbird folder, select Mozilla 

Thunderbird.  
 

 
 

• The Mozilla mail window will appear.  
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Using Mozilla Mail 
Once Mozilla has been configured to recognize your e-mail 
account, your new e-mail will be delivered to your Mozilla Inbox, 
from which you can read, reply to, and forward your e-mail.  
 
 
Accessing your Inbox 
• In the Mail toolbar, click on the button labeled Get Mail. 
 

 
 

• Locate the section of the Navigation pane labeled Folders. 
 

 
 

• To access the inbox containing your Trumpeter e-mails: 
o Click on the plus sign located next to the folder labeled 

Tufts Email Account 
 

 
 

o Click on the folder labeled Inbox.  
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• The View pane will display the contents of your inbox. 
Clicking on the header labeled date allows you to arrange your 
emails so that the recently received items are at the top or at 
the bottom on the pane.  

 

 
 
 
• Mozilla allows you to decide which e-mails you wish to view.  

o Click on the down-facing arrow located next to the box 
labeled View. 

o From the menu that appears, select the method you 
wish to use. 
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Searching for an e-mail 
To search your inbox for e-mails pertaining to certain subjects or 
particular senders: 
• Click on the down-facing arrow located next to the magnifying 

glass. 
• From the menu that appears, select the search criteria for your 

emails. 
 

 
 

• In the box next to the magnifying glass, type in the subject 
and/or sender you are searching for. 

• Click on the Enter key on your keyboard. 
• E-mails containing your search content will appear in the View 

pane. 
 

 
 

Reading incoming mail 
Mozilla gives you several options for viewing your e-mails. You 
can view an e-mail in the reading pane or open up the e-mail in a 
new window.  
 
Reading your mail 
Unread mail will appear in the View pane with the sender’s name 
in bold-faced printing and with a closed envelope icon. 
 

 
 
Reading an e-mail from the Reading pane 
• Click once anywhere in the box containing the sender’s name 

and subject. 
• The text of the e-mail will appear in the Reading pane. 
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Reading an e-mail in a new window 
If the body of the e-mail is particularly long, you may need to open 
the e-mail in a new window. 
• From the View pane, double-click anywhere in the box 

containing the sender’s name and subject. 
• A new window will appear displaying your new e-mail.  
 

 
 
 

Opening and Reading Attachments 
Attachments are files that are sent along with an e-mail, rather then 
in the body of the message. 
 
Opening attachments 
• When you receive a message with an attachment, your e-mail 

will appear with a paperclip icon in the View pane. 
 

 
 

• Click anywhere in the box containing the sender’s name and 
subject so that the e-mail appears in the Reading pane. 

 6  



• In the Reading pane, double-click on the attachment’s icon 
(for example, Filtering in Excel 2003 Learning Guide).   

 

 
 

• The Opening Attachment window will appear, asking you 
whether you would like to save or open the attachment.  

 

 
 

• If you would like to open the attachment immediately: 
o Click on the button labeled Open with. 
o Click on the button labeled OK. 
o Windows will launch the attachment with the required 

program for the application.  
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• If you would like to save the attachment and open it later: 
o Click on the button labeled Save to Disk. 
o Click on the button labeled OK. 

 

 
 

o The Name of file to save to window will appear.  
 

 
 

o Navigate to the folder where you would like to save the 
attachment.  

o In the box labeled File name, type in a name that you 
wish to give to your attachment. 

o Click on the button labeled Save. 
o The attachment will be saved in the designated location. 
o You can now open the attachment from that location. 
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Reading attachments 
Attachments are files that are sent along with an e-mail, rather than 
in the body of the message. 
• A list of attachments will appear under the recipient line of 

your e-mail.  
 

 
 

• Double click on the name of the attachment you would like to 
open. 

• The Open Attachment window will appear.  
• Click on the button labeled Open.  
• The attached file will open in the appropriate program. 
 
Tip: Never open an attachment from someone you do not know, or 

an unexpected or unexplained attachment from someone you 
do know. This is hoe computer viruses spread. If you are not 
sure, contact the sender to make sure the attachment is safe.  

 
 
 
Composing and sending an e-mail 
Composing your e-mail 
• From the Mail toolbar, click on the button labeled Write. 
 

 
 

• The Compose window will appear.  
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• In the box labeled Subject, type the subject of your e-mail (for 
example, Composing an Email). 

 

 
 
 

Addressing your e-mail 
• In the box labeled To, type the recipient’s e-mail address (for 

example, lauren.daley@tufts.edu).  
 

 
 

• If you wish to look up the e-mail address of one of your 
exchange or personal contacts, click on the button labeled 
Contacts.  

 

 
 

• The Contacts window will appear and allows you to search 
through address books for contacts. 

 

 
 

• In the box labeled Address Book, click on the down-facing 
arrow to select the appropriate book you want to search in. 

• In the box labeled Search For, type in the name or the e-mail 
address of the contact you are searching for. 

• In the box labeled Name, names that match your descriptions 
will appear.  

• Click on the appropriate contact name. 
• Click on the button labeled Add to To: or Add to Cc: to add 

the contact to your e-mail.  
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Composing your e-mail message 
• In the white area below the box labeled Subject, type the 

message you wish to send.  
 

 
 

 
 
Checking your e-mail for grammar and spelling mistakes 
• Click on the ABC Spell button located on the Mail toolbar. 
 

 
 

• The Check Spelling window will appear.  
• From this window, correct the spelling and grammar of your e-

mail as you would in a Word document.  
• When you have finished, a window will appear telling you that 

the spelling and grammar check is complete.  
• Click on the button labeled Close.  
 

 

 11  



Sending your e-mail 
To send your final e-mail: 
• Click on the button labeled Send. 
 

 
 

• Mozilla will send your e-mail to the intended recipient. 
 
 
 
Attaching a file to your e-mail 
Sometimes it is necessary to electronically transmit files with an e-
mail. For example, if you wanted your colleague’s opinion on a 
research proposal, you could attach the entire proposal to an e-mail 
and send it to him or her instantaneously. This would allow your 
colleague to respond as soon as possible. To attach a file to your e-
mail: 
• In the Mail toolbar, click on the down-facing arrow next to the 

button labeled Attach. 
 

 
 

• From the menu that appears, select File(s). 
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• The Attach File(s) window will appear. 
 

 
 

• Navigate to the file that you would like to attach to your e-
mail. 

• Click on the file to select it. 
• Click on the button labeled Open. 
• Mozilla will attach the selected file to your e-mail. 
• A list of attached files will appear in the box labeled 

Attachments.  
 

 
 
 
• To attach additional files to your e-mail: 

o Click on the button labeled Attach located on the Mail 
toolbar. 

o The Attach File(s) window will appear.  
o Navigate to the file you wish to attach and select it. 
o Click on the button labeled Open. 
o Mozilla will attach the selected file to your e-mail. 
o Continue this process until you have attached all the 

necessary files.  
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• To remove an attached file from an e-mail: 
o Click on the attached file that you wish to remove. 
o Press the Delete key on your keyboard. 
o Mozilla will remove the attached file from your e-mail.  

 
• When you are satisfied with your e-mail message, click on the 

button labeled Send. 
 

 
 
 
Tip: Opening an attachment before sending it 
Before sending an e-mail you may want to ensure you have 
attached the correct file. To open an attachment: 
• Double-click on the attached file 
• The Attached File(s) window will appear.  
• Click on the button labeled Open. 
• Mozilla will open your attached file so that you can make sure 

it is the correct one.  
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Replying to and forwarding e-mails 
When you have received an e-mail, you can reply directly to that e-
mail or forward the e-mail to a colleague for input. 
 
 
Replying to an e-mail 
When you reply directly to an e-mail your message will include the 
text of the original e-mail, which may be useful for the original 
sender in terms of remembering exactly what he or she had written 
to you. To reply to an e-mail: 
• From your Inbox, locate the e-mail you wish to reply to. 
• In the View pane, click on the e-mail so that it is highlighted in 

blue. 
• Click on the button labeled Reply. 
 

 
 

• The Compose: Re window will appear.  
o The cursor will appear below the original message, with 

the basic information about the original message 
included. 

• Type your reply message where the cursor is blinking. 
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• When you are finished composing your reply e-mail, click on 
the button labeled Send.  

 

 
 

Tip: Replying to All Recipients 
If you receive an e-mail that was also sent to additional 
colleagues, you may wish to send you reply to all recipients of the 
e-mail. To reply to all recipients: 
• In the View pane, click once on the e-mail you wish to reply to 

that it is highlighted in blue. 
• Click on the button labeled Reply All. 
 

 
 
• The Compose: Re window will appear.  
• Type your reply below the original message. 
• Click on the button labeled Send. 
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Forwarding an e-mail 
If you receive an e-mail that you would like someone else to read, 
you can forward it directly to that person. To forward an e-mail: 
• From your Inbox, locate the e-mail you wish to forward. 
• In the View pane, click on the e-mail so that it is highlighted in 

blue. 
• Click on the button labeled Forward.  
 

 
 

• The Compose: Fwd window will appear.  
 

 
 

• In the box labeled To, type the e-mail address(es) of the 
recipient(s) you wish to forward your e-mail to. 

• Type any additional messages that you would like to include 
below the original message. 

• When you are finished composing your e-mail, click on the 
button labeled Send. 

 

 

 17  



Organizing your e-mails  
You can organize and categorize your e-mails by creating folders 
and dropping your e-mails into them. To create a new folder: 
• From the File menu, select the New submenu. 
• From the New submenu, select New Folder. 
 

 
 

• The New Folder window will appear.  
 

 
 

• In the box labeled Name, type a detailed name that you wish to 
give to your new folder.  

• Click on the down-facing arrow located next to the box labeled 
Create as a subfolder of. 

• From the menu that appears, select the subfolder for your new 
folder.  

• Click on the button labeled OK.  
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• The folder you created will appear in the Folders area in the 
location that you selected.  

 

 
 

• Drag the e-mail(s) that you wish to place in the folder you 
created.  

• Repeat the process if you want to create another folder and/or 
place another e-mail into a folder.  

 

 19  



Using Mozilla’s Contacts 
The Contacts section of Mozilla allows you to store and retrieve 
information about your colleagues, friends, and family. Mozilla’s 
Contacts are closely integrated with Mail, and can be used to 
quickly address e-mails. Contacts: 
 
Mozilla’s… Consists of… 
Personal Contacts Friends, family members, or colleagues that are 

not on Tufts’ exchange. You must add these 
contacts individually and they can be used with 
any e-mail accounts that you have incorporates 
into Outlook.  

 
 
Adding a personal contact 
To add a new personal contact to your address book: 
• From the File menu, select the New submenu. 
• From the New submenu, select Address Book Card. 
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• The New Card window will appear.  
• In the boxes, fill in the name of your new contact and any other 

information that you would like to save.  
• When you have completed the new card, click on the button 

labeled OK. 
 

 
 
 
 

Editing your personal contacts 
Your contacts names and any information associated with them 
will appear when you open up your Address Book. To edit your 
contact information: 
• Click on the button labeled Address Book located on the Mail 

toolbar.  
 

 
 

• The Address Book window will appear.  
• Double click on the contact you wish to edit. 
• The Edit Card window will appear.  
• Fill in the boxes that appear with any new information or edit 

existing information about your contact.  
• Click on the button labeled OK when you are finished.  

 21  



Searching for a contact 
• Click on the button labeled Address Book. 
• The Address Book window will appear.  
• From the Edit menu, select Search Addresses. 
 

 
 

• The Advanced Address Book Search window will appear.  
• In the boxes, select your search criteria and type in the name 

you are looking for. If you do not know a full name you can 
search under a wider spectrum. 

• Click on the button labeled Search. 
• Any contact matches will appear at the bottom of the search 

box. 
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Another way to search for a contact 
• Open up the Address Book window.  
• Click in the box labeled Name or Email located next to the 

magnifying glass icon.  
• In the box, type in a name or an e-mail address that you wish to 

search for. 
 

 
 
• Press the Return key on your keyboard.  
• Any matches to your search will appear in the box at the 

bottom of the window.  
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